
 

PRACTICAL WORKBOOK 
FOR ACADEMIC SESSION 2014 

 
 

ANALOG INTEGRATED CIRCUITS (EL-302) 
THIRD YEAR ELECTRONICS 

 
 
 
                              
                     
 
 
 
 
                     

 
 
 
 

 
 
 

Department of Electronic Engineering 
NED University of Engineering and Technology, Karachi 

 
 
 



LABORATORY WORKBOOK 
 

FOR THE COURSE 
 

EL-302 ANALOG INTEGRATED CIRCUITS 
 
 
 
 

 

Prepared By: 
 

Ms. Ayesha Akhtar (Lecturer) 
 
 
 
 
 
 
 
 

Reviewed By: 
 

Dr. Ghous Bakhsh Narejo (Associate Professor) 
 

 
 
 
 
 
 
 

Approved By: 
THE BOARD OF STUDIES OF DEPARTMENT OF ELECTRONIC ENGINEERING 

 
 
 



ANALOG INTEGRATED CIRCUITS LABORATORY 
 

CONTENTS 
 
 

Lab No. Date List of Experiments Page 
No. 

Remarks 

 
1 

 Introduction to Mentor Graphics 1-4  

 
2 

 To learn how to use IC Studio of Mentor Graphics for IC 
Designing 

5-12  

 
3 

 To determine the dc operating points of MOSFET operating in 
saturation region. 

13-17  

 
4 

 To determine the behavior of MOS transistor using Mentor 
Graphics by analyzing its  

 ID v/s VDS curve  
 ID v/s VGS curve 

18-22  

 
5 

 To determine the behavior of a Comm on Source Am plifier 
circuit using Mentor Graphics. 

23-24  

 
6 

 Design and sim ulate simple MO S current mirror and cu rrent 
amplifier using Mentor Graphics. 

25-27  

 
7 

 Design and simulate cascade current mirror using Mentor  
Graphics. 

28-30  

 
8 

 To study different designs of constant current sources  31-39  

 
9 

 To analyze the frequency response of Common Emitter 
Amplifier. 

40-47  

 
10 

 To analyze the frequency response of Cascode Amplifier and 
compare it with Common Emitter Amplifier.

48-51  

 
11 

 Design and analyze a Common Gate Amplifier circuit.  52-56  

 
12 

 To demonstrate the properties of differential amplifiers in both 
common mode and differential mode. 

57-61  

 
13 

 To measure the open loop gain and offset voltage of an op 
amp. 

62-65  

14  To measure the slew rate and bandwidth of an op amp. 
 

66-68  

 



 
Analog	Integrated	Circuit	 	 Lab	No.1 

1 

 

NED University of Engineering & Technology, Department of Electronic Engineering  

 

Lab No. 1 

 

INTRODUCTION: 

We will be working in three regions during AIC lab. 

First of all you will be introduced to a new software i-e Mentor Graphics (IC Studio).  

Secondly you people will have to implement labs on Orcad PSpice, which will the work done in 
pre-lab. 

Thirdly you will be implementing circuits on bread board so as to get hands on experience. 

Before coming to the introduction of Mentor Graphics let’s have a look at the types of ICs: 

  

TYPES OF IC: 

1. Standard Product 
2. Application Specific Integrated Circuit (ASIC) 

a) Full Custom 
b) Semi custom 

 
1. STANDARD PRODUCT: 

A standard product is produced by the manufacturer for sale to the general 
public. Standard products are readily available for use by anybody for a wider range of 
applications. 

 
2. APPLICATION SPECIFIC INTEGRATED CIRCUIT (ASIC) 

The term 'ASIC' stands for 'application-specific integrated circuit'.  An ASIC is 
basically an integrated circuit designed specifically for a special purpose or 
application. Strictly speaking, this also implies that an ASIC is built only for one and only 
one customer. An example of an ASIC is an IC designed for a specific line of cellular phones 
of a company, whereby no other products can use it except the cell phones belonging to that 
product line. The opposite of an ASIC is a standard product or general purpose IC, such as a 
logic gate or a general purpose microcontroller, both of which can be used in any electronic 
application by anybody. 

   
Aside from the nature of its application, an ASIC differs from a standard product in the    

nature of its availability.  The intellectual property, design database, and deployment of an  
 



 
Analog	Integrated	Circuit	 	 Lab	No.1 

2 

 

NED University of Engineering & Technology, Department of Electronic Engineering  

 
ASIC is usually controlled by just a single entity or company, which is generally the end-

user of the ASIC too.  Thus, an ASIC is proprietary by nature and not available to the general 
public.  

 

a) FULL-CUSTOM 

Full-custom ASIC's are those that are entirely tailor-fitted to a particular application from 
the    very start.  Since its ultimate design and functionality is pre-specified by the user, it is 
manufactured with all the photolithographic layers of the device already fully defined, just 
like most off-the-shelf general purpose IC's. The use of predefined masks for manufacturing 
leaves no option for circuit modification during fabrication, except perhaps for some minor 
fine-tuning or calibration. This means that a full-custom ASIC cannot be modified to suit 
different applications, and is generally produced as a single, specific product for a particular 
application only.   

b) SEMI-CUSTOM ASIC:  

Semi-custom ASIC's, on the other hand, can be partly customized to serve different 
functions within its general area of application. Unlike full-custom ASIC's, semi-custom 
ASIC's are designed to allow a certain degree of modification during the manufacturing 
process.   A semi-custom ASIC is manufactured with the masks for the diffused layers 
already fully defined, so the transistors and other active components of the circuit are already 
fixed for that semi-custom ASIC design. The customization of the final ASIC product to the 
intended application is done by varying the masks of the interconnection layers, e.g., the 
metallization layers.   

 

INTRODUCTION TO MENTOR GRAPHICS: 

Mentor Graphics IC Studio is an EDA software .Electronic Design Automation (EDA or 
ECAD) is a category of software tools for designing electronic systems such as printed circuit 
boards and integrated circuits. The tools work together in a design flow that chip designers use to 
design and analyze entire semiconductor chips. 

 

TOOLS IN MENTOR GRAPHICS: 

1. Back end tools - IC Nanometer Design- Category 1 

2. Front end tools-Design Verification & Test- Category 2 

3. PCB Tools - PCB PADS- Category 3b 
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We will be using the Back end tools 

 

Fig 1.IC Nanometer Design 

 

 Design Architect-IC - A powerful tool for schematic capture, netlisting, simulation setup 
and results viewing. 

 IC Station - Provides the physical layout component of the Mentor Graphics full custom 
IC design flow. This suite includes application bundles for editing, schematic-driven 
layout, and top-level floor planning/routing. 

 IC assemble - A robust set of features for floor planning, top-level assembly and 
interactive routing. 

 ADVance MS and ADVance MS RF - A language-neutral, mixed-signal simulator that 
enables top-down design and bottom-up verification of multi-million gate analog/mixed-
signal SoC designs. 

 Eldo and Eldo RF - An analog simulator offering numerous simulation and modeling 
options that deliver high-performance and high-speed simulation with the accuracy 
required by the user. 

 Calibre - The industry standard platform for physical verification, offering superior 
performance and capacity for both flat and hierarchical algorithms. 

 CalibrexRC - Accurate transistor-level, gate-level and hierarchical parasitic extraction. 
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TECHNOLOGY FILE  

The technology file contains process specific parameters such as layer thicknesses and the 
sheet resistance of the various layers. 

Mentor's Technology Design Kit is a comprehensive and proven set of building blocks 
that enables semiconductor companies and electronics systems manufacturers to jump-start their 
design cycles using Mentor's analog/mixed-signal (AMS) IC Flow, thereby cutting time-to-
market and ensuring manufacturing success of analog, RF and mixed-signal ICs and systems on 
chip (SoCs). 

Mentor Graphics and GLOBALFOUNDRIES Semiconductor have teamed to develop 
TDKs for popular GLOBALFOUNDRIES manufacturing processes at multiple technology 
nodes, starting first with 0.18 micron. These AMS TDKs include all the foundry-specific data 
files and models for use with the Mentor Graphics integrated IC Flow comprised of the 
following tools: Design Architect-IC for schematic entry, Eldo and ADMS for analog and 
mixed-signal simulation, IC Station and IC assemble for schematic-driven layout and chip 
assembly, and Calibre for DRC/LVS verification and extraction. 
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Lab No. 2 

OBJECTIVE: 

To learn how to use IC Studio of Mentor Graphics for IC Designing 

 

EQUIPMENT REQUIRED:  

Linux and Mentor Graphics (IC Studio) installed PC 

 

THEORY: 

Mentor Graphics IC Studio is an EDA software .Electronic Design Automation (EDA or ECAD) 
is a category of software tools for designing electronic systems such as printed circuit boards and 
integrated circuits. The tools work together in a design flow that chip designers use to design and 
analyze entire semiconductor chips. 

 

PROCEDURE: 

Launching IC Studio: 

Open a new terminal and type the following commands: 

 ------------------------------------ 
 

 ------------------------------------ 
 

 ------------------------------------- 
 

This will launch the window of ic_studio as shown below: 
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Creating a Project: 

On the IC Studio window  

 Click File>New>Project to create a new project. 
 Click Next  in the New Project pop-up window 
 Enter the Project name (e.g project1) and the Project Location (home/student), click 

Next in the New Project popup window. 
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Specifying Location Map: 

On the next window that appears 

 Click the Open Location Map Editor button. The Location Map Editor appears. 
 To add the design kit’s standard cell libraries to the library list 

Click Edit Menu > Add Standard MGC Libraries pull down menu item 
 Add the MGC  Design kit to the location map 
 Click Edit Menu > Add MGC Design kit. 
 Specify MGC Design Kit Path as  

 
----------------------------------------------------------------- 

 The Library List editor looks as in the figure below. 
 Click OK on the Library List Editor 
 Click Next on the New Project pop-up window. 
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Specifying Process files and other settings: 

 Click Open Settings Editor button. The Project tab of the Preferences dialog box 
appears 

 Load the process file and rule files. 
Process file and rule files are present in  
 
Process file:----------------------------------------- 
 
DRC rules file:------------------------------------- 
 
LVS rules file:-------------------------------------- 
 
SDL rules file:-------------------------------------- 
 
PEX rules file:-------------------------------------- 
 

 Click OK on the Preferences dialog box. 
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 Click Next on the New Project pop-up window 
 View the Summary to make sure all the information is correct. 
 Click Finish. 

 

Creating a Library: 

 Click File >New > Library .This opens the Create Library dialogue box. 
 Enter the name of the library you want to create (e.g. lib) 
 Click OK. 

The library appears in the IC Studio library pane as well as in the location map. 
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Capturing a Cell: 

To create a new Schematic cell: 

 Select a library (e.g lib) where you want a cell view to be created. 
 Click File > New >Cell View .The Create New View dialogue box appears 
 Enter the Cell Name (e.g current source).If the cell does not exist, it is created. 
 Specify the View Type as Schematic and click Finish. 
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Design Architect (DA-IC) will open automatically where in you can capture the required 
cell design. 
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Lab No. 3 

OBJECTIVE: 

To determine the dc operating points of MOSFET operating in saturation region. 

 

EQUIPMENT REQUIRED:  

Linux and Mentor Graphics (IC Studio) installed PC 

 

THEORY: 

Modes of operation of MOSFET: 

MOSFET can be operated in three modes: 

1) Cut off 

2) Triode 

3) Saturation 

To operate the MOSFET as a current source it needs to be operated in saturation region. For an 
N-MOS to operate in saturation region the operating conditions must be such that  

	஽ௌݒ ൒ 	 ௌீݒ െ ௧ܸ 

Ideally the current that flows through the MOSFET in saturation region is independent of drain 
voltage and is given by: 

݅஽ ൌ
1
2
	μ௡	ܥ	௢௫

ܹ
ܮ
	ሺீݒௌ െ ௧ܸሻଶ	 

But practically increasing ݒ஽ௌ beyond ݒ஽ௌ	௦௔௧ causes the channel pinch off point to move slightly 
away from the drain towards the source which is as shown in figure 1: 
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Figure 1: Increasing ݒ஽ௌ beyond ݒ஽ௌ	ௌ௔௧	 reduces the effective channel length. 

Hence the voltage across the channel remains constant at ீݒௌ െ ௧ܸ		 ൌ  ௦௔௧ and the additional	஽ௌݒ
applied voltage applied to the drain appears as a voltage drop across the narrow deplition region 
between the end of the channel and the drain region .This voltage accelerates the electrons that 
reach the drain end of the channel and sweeps them across the depletion region into the 
drain.Now since ݅஽ is inversely propotional to the channel length , ܫ஽ increases with ஽ܸௌ	. 

݅஽ ൌ
1
2
	μ௡	ܥ	௢௫

ܹ
ܮ
	ሺீݒௌ െ ௧ܸሻଶ	ሺ1 ൅  ሻ	஽ௌݒߣ

PROCEDURE: 

Launch IC Studio on Linux as explained in Lab Session 1. 

 

Capturing a Cell: 

 Select a library (e.g lib) where you want a cell view to be created. 
 Click File > New > View. The Create New View dialog box appears. 
 Enter the Cell Name (e.g current source) .If the cell does not exist, it is created. 
 Specify the View Type as Schematic and click Finish. 
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Design Architect (DA-IC) will open automatically where in you can capture the required 
cell design. 
 
Schematic Entry: 

 Select the parts for your schematic of the current source by choosing from a 
library of components. 
To place the transistor on the sheet: 

 In the palette on RHS click on Add Device and in select nmos. 
 In the palette menu shown alongside, click on  Library  
 In the subsequent palette menu click on Device Lib. 

 Select ideal resistor and place it on the sheet by clicking on the position you 
wish to place it. Click BACK to go to the IC Library palette and click on 
Generic Lib. Place VDD, PORTOUT and Ground on the sheet. 
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 Add a DC source by selecting IC Library >Sources Library > DC. 
Highlight the DC Source, right click mouse, go to Properties > Edit to modify 
the voltage value of the source from 1V to 3.3V. 

 From the Schematic Edit Palette select wire and wire the components as per the 
schematic shown below. 

 Change the label NET of the PORTOUT symbol to OUT: Place cursor on NET, 
right click it then go to Properties. A display menu appears .Type OUT in the 
Value and click OK. 

 To change the value of resistance place cursor on resistor, right click then go to 
Properties. A display menu appears, in it change the value to 150 and click OK. 

 Click Check & Save from the Schematic Edit Palette or in the Menu Bar to 
check and save your sheet. 

 Now click the simulation button. 
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Setting up the Simulation Parameters: 

Perform the simulation setup (all the ten steps) as explained in lab and view the dc 
operating points. 
 
 
RESULT: 
Attach the printout of the results i-e DC operating point of MOSFET operating in 
saturation region. 
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Lab No.4 

OBJECTIVE: 

To determine the behavior of MOS transistor using Mentor Graphics by analyzing its  
 ID v/s VDS curve  
 ID v/s VGS curve 

 

EQUIPMENT REQUIRED:  

Linux and Mentor Graphics (IC Studio) installed PC 

 

THEORY:  

The physical operation of a MOSFET can be divided into three regions of operation. For small 
value of VG the transistor is switched off. For an NMOS transistoras VGS increases from zero, 
holes in the p-substrate under the gate are repelled. Thus a depletion region is created from drain 
to source. For a sufficient value of interface potential, electron from source can actually travel 
through interface to drain terminal. The value of interface potential at this stage is called 
“Threshold Voltage” (Vt).  

When VGS>Vt and VDS<( VGS - Vt ): Triode of Linear Region  

In this region of operation MOSFET operates like a resistor, controlled by the gate voltage 
relative to both the source and drain voltages. The current from drain to source is modeled as:  

 

஽ܫ ൌ μ௡	ܥ	௢௫
ܹ
ܮ
	ሾሺܸீ ௌ െ ௧ܸሻ ஽ܸௌ െ	

஽ܸௌమ

2
	ሿ 

 
whereμn is the charge-carrier effective mobility, W is the gate width, L is the gate length and Cox 
is the gate oxide capacitance per unit area.   

 
When VGS>Vt and VDS>( VGS - Vt ): Saturation Region  

The switch is turned on, and a channel has been created, which allows current to flow between 
the drain and source. Since the drain voltage is higher than the gate voltage, the electrons spread 
out, and conduction is not through a narrow channel but through a broader, two- or three-
dimensional current distribution extending away from the interface and deeper in the substrate. 
The onset of this region is also known as pinch-off to indicate the lack of channel region near the 
drain. The drain current is now weakly dependent upon drain voltage and controlled primarily by 
the gate–source voltage, and modeled very approximately as:   
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஽ܫ ൌ
1
2
μ௡	ܥ	௢௫

ܹ
ܮ
ሺܸீ ௌ െ ௧ܸሻଶሺ1 ൅ ߣ ஽ܸௌ	ሻ 

 
Figure 1:ID v/s VDS curve for different values of V GS 

 
 

 
Figure 2:ID v/s VGScurve  



Analog	Integrated	Circuit	 	 Lab	No.4 

20 
 

NED University of Engineering & Technology, Department of Electronic Engineering 

 

The characteristic curve of Fig. 1 indicates three regions of operation. The cutoff region, the 
triode region and the saturation region. The device is cutoff when VGS<Vt whereas it follows a 
linear relationship in triode region. The MOS operation, therefore, can be modeled as a linear 
resistor in triode region. Saturation region on the other hand is used when MOS is employed as 
an amplifier. In saturation region MOS provides a drain current which is independent of VDS and 
is determined by VGS according to a square law relationship. Thus Fig. 2 shows MOSFET 
operation as an ideal current source whose value is controlled by VGS.  

PROCEDURE: 

Launch IC Studio on Linux as explained in Lab Session 1. 

Capturing a Cell and Schematic Entry: 

For ID v/s VDScurve: 
Draw the following schematic by following the steps given in Lab Session 2. 
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 In the circuit set the Instantaneous Value of source connected between gate and source 
as vgs and its dc value as vgate. 

 Similarly set the instantaneous value of dc source connected between drain and source 
as vds and its dc value will be by default 1V. 

 

Setting up the Simulation Parameters: 

 Now perform step 1 to 4 of lab 2. 

 Set the Setup Analysis as DC and then sweep vds,  
 
Defining Parameters: 

 Select  Setup Outputs and goto 
     Parameter Sweeps 
     In Parameter Type select Global  
     Set Parameter as vgate and its value 0 

Select Range type as linear and specify the range of vgate. 
Add these parameters. 

 Now perform steps 6, 7, 8 and 9 from lab 2. 

 

Viewing the Results using EZWave Viewer: 

 Under (name of schematic) open the List tab then drag the drain current to the waveform 
window. 

 
 

ID v/s VGS curve: 
Now implement changes in the schematic and simulation setup required. Also mention all the   
steps. 

 
 
 
 
 
 
 
 

 

 

 



Analog	Integrated	Circuit	 	 Lab	No.4 

22 
 

NED University of Engineering & Technology, Department of Electronic Engineering 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
RESULT: 
Attach the printout of the results i-e  

 ID v/s VDS curve  
 ID v/s VGS curve 
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Lab No.5 

OBJECTIVE: 

To determine the behavior of a Common Source Amplifier circuit using Mentor Graphics. 
 

EQUIPMENT REQUIRED:  

Linux and Mentor Graphics (IC Studio) installed PC 

 

THEORY:  
A common-source amplifier is one of three basic single-stage field-effect transistor (FET) 
amplifier topologies, typically used as a voltage or transconductance amplifier. The easiest way 
to tell if a FET is common source, common drain, or common gate is to examine where the 
signal enters and leaves. The remaining terminal is what is known as "common". In this example, 
the signal enters the gate, and exits the drain. The only terminal remaining is the source. This is a 
common-source FET circuit. The analogous bipolar junction transistor circuit is the common-
emitter amplifier. 
The common-source (CS) amplifier may be viewed as a transconductance amplifier or as a 
voltage amplifier. As a transconductance amplifier, the input voltage is seen as modulating the 
current going to the load. As a voltage amplifier, input voltage modulates the amount of current 
flowing through the FET, changing the voltage across the output resistance according to Ohm's 
law. However, the FET device's output resistance typically is not high enough for a reasonable 
transconductance amplifier (ideally infinite), nor low enough for a decent voltage amplifier 
(ideally zero). Another major drawback is the amplifier's limited high-frequency response. 
Therefore, in practice the output often is routed through either a voltage follower (common-drain 
or CD stage), or a current follower (common-gate or CG stage), to obtain more favorable output 
and frequency characteristics. The CS–CG combination is called a cascode amplifier. 
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PROCEDURE: 

Launch IC Studio on Linux as explained in Lab Session 1. 

Capturing a Cell and Schematic Entry: 

Draw the schematic by following the steps given in Lab Session 2. 

Select the drain current and gate to source voltage from the id-vds curve in lab 3, and then 
calculate the value of drain resistance. 

Setting up the Simulation Parameters: 

 Now perform step 1 to 4 of lab 2. 
 Set the  Setup Analysis as Transient and click on setup associated with it. 

In the Setup box that appears type 10m in the stop field and 100n in Max time step 
field .then click OK. 

 Set the Setup Outputs as Transient. 
 Perform steps 7, 8 and 9 as in lab 2. 

 

Set up the simulation parameters as explained in lab and view waveform in EZ viewer. 

 
CALCULATION: 
The gain of the amplifier is: 
 

RESULT: 

Attach the printout of input and output waveform along with their peak-to-peak voltage 
measurement. 
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Lab No.6 

OBJECTIVE: 

Design and simulate simple MOS current mirror and current amplifier using Mentor Graphics. 
 

EQUIPMENT REQUIRED:  

Linux and Mentor Graphics (IC Studio) installed PC 

THEORY:  
 
Current Mirrors are fundamental building blocks of Analog Integrated Circuits. Operational 
amplifiers, operational transconductance amplifiers and biasing networks are examples of 
circuits that are composed of current mirrors. Analog integrated circuit implementation 
techniques such as current mode and switched current use current mirrors  as the basic circuit 
element .Thedesign and layout of current mirrors is therefore an important aspect of successful 
analog circuit design. 
 In the simplest form a current mirror is composed of two transistors as shown in Fig.1. 
Transistor M1 is diode connected transistor and acts as a low impedance input of the current 
mirror .the drain of M2 is the output of current mirror. 
 
 

 
Figure 1: Simple current mirror 

 
 
Since the gate to source voltage is the same for both the transistors then according to the first 
order MOSFET model, the drain currents will be equal .This assumes that the transistor sizes are 
equal as well as the process parameters. 
 
A current mirror is used to mirror the input current into the output branch .A current (Iin) entering 
the diode connected the transistor establishes a gate voltage (VGS).The gate voltage causes Iout to 
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low through the output transistor.  
 
If the ratio of the transistors is changed, then the current mirror acts as a current amplifier. The 
gain of the amplifier is given by: 

 
 
The above analysis assumed ideal operation of the current mirrors meaning that the drain 
currents are independent of VDS; however, due to channel length we know this is not true. 
The following equation represents the dependence of drain current on VDS. 

 

 

஽ܫ ൌ
1
2

µ௡	ܥ	௢௫
ܹ
ܮ
ሺܸீ ௌ െ ௧ܸሻଶሺ1 ൅ ߣ ஽ܸௌ	ሻ 

The excess current due to the differences in VDS1 and VDS2 will cause a difference in  
ID1 and ID2 . To reduce “lambda” effects, the drain to source voltages of the two transistors need 
to be kept equal. 
 
PROCEDURE: 

Launch IC Studio on Linux as explained in Lab Session 1. 

Capturing a Cell and Schematic Entry: 

Implement the circuit of MOS Current Mirror, MOS Amplifier and Cascode Current Mirror  
 
 
Setting up the Simulation Parameters: 

 Perform the steps given in lab 2 and determine the dc operating points of MOS Current Mirror, 
MOS Amplifier and Cascode Current Mirror. 

 Also calculate the percentage difference in the output and input current in all the three cases. 
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Calculations: 

Simple current mirror: 

Iref Io 
  
 
% error: 
 
 
 
Current Amplifier: 
 

Iref Io 
  
 
% error: 
 
 
 
RESULT: 

Attach the printout of 
1) Simple MOS current mirror 
2) MOS Amplifier 
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Lab No.7 

OBJECTIVE: 

Design and simulate cascade current mirror using Mentor Graphics. 
 

EQUIPMENT REQUIRED:  

Linux and Mentor Graphics (IC Studio) installed PC. 

 
]THEORY:  
 
 

 
Figure 1: Simple current mirror 

 
 

 
 
The above figure shows a simple current mirror .these current mirrors have non ideal effect that 
is having limited range of VDS2.Since M1 remains in saturation for all input currents due to its 
diode connected configuration, M2 needs to be kept in saturation to assume proper operation .If 
VDS2 drops too low, M2 will enter the triode region, and the output current will be much less than 
what is wanted. The minimum output voltage for the current mirror is sometimes referred to as 
the compliance voltage .For the simple current mirror, the compliance voltage is VDS sat2 . 

 

Hence to obtain good matching between input and output currents, the drain to source voltages of 
M1 and M2 must be kept equal .One way to achieve this is by using a cascode current mirror 
which is as given in figure 2. 
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Figure 2: Cascode Current Mirror 

 
Transistors M1 and M2 determine the ratio of the input and output currents. M3 biases M4 which 
is used to control the drain voltage of M2. If designed correctly ,VDS1 is approximately equal to 
VDS2 .The benefits of the cascade current mirror are better matching of output currents and larger 
output resistance .The disadvantage is that a larger compliance voltage is needed to keep both 
M3 and M4 in saturation. The compliance voltage of Figure 2 is given by: 
 
Node 1: The voltage here is VGS1 =VT +VDSSat1. 
Node 2: For good matching between input and output currents, we want VDS1 and VDS2 to be 
equal .thus, the voltage at node 2 is also VT +VDSsat1. 
Node 3: The minimum compliant voltage will be the minimum voltage to keep M3 and M4 is 
saturation .This will be VT+VDSsat1 + VDSsat2. 
 
As you can see, adding the cascode transistor does not just increase the required compliance 
voltage by one VDSsat, it also increases it by a threshold voltage  
 
PROCEDURE: 

Launch IC Studio on Linux as explained in Lab Session 1. 

Capturing a Cell and Schematic Entry: 

Implement the circuit of MOS Current Mirror, MOS Amplifier and Cascode Current Mirror  
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Setting up the Simulation Parameters: 

 Perform the steps given in lab 2 and determine the dc operating points Cascode Current Mirror. 
 Also calculate the percentage difference in the output and input current in all the three cases. 

 

Calculations: 

 
Cascode Current Mirror: 
 

Iref Io 
  
 
% error: 
 
 
RESULT: 

Attach the printout of Cascode Current Mirror 
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Lab No. 8 

OBJECTIVE: 

To study different designs of constant current sources 
 
This lab is designed to familiarize the student with the operation of two different designs of 
constant current sources. In particular, the operation of a simple BJT current source will be 
explored as well as the one of the so-called Wilson current mirror.TheWilson mirror is an 
improved current source circuit with a more stable output resistance. 
 

  The laboratory experiment is divided into TWO activities: 
(A)The first activity involves the operation of a simple 2-BJT current-mirror constant   
current source. 
(B)The second activity involves the operation of an improved 3-BJT constant current 
source (Wilson current mirror) that exhibits a more stable output resistance. 
 

 

EQUIPMENT REQUIRED:  
Protoboard 
Function Generator 
Digital Multimeter 
Power Supply 
Resistors:1 x 10 kΩ, 1 x 470 Ω, 2 x 1kΩ,  
Transistors: 3 x 2N3904,  

 

THEORY: 

THE BASIC BJT CURRENT SOURCE: 

 

Fig 1: Analysis of the current mirror taking  Fig 2: A Simple BJT current  
into account the effect of finite β               source  
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The basic BJT current mirror is shown in Fig.6.9.Let us consider the case when β is 
sufficiently high so that we can neglect the base currents. The reference current IREF is passed 
through the diode-connected transistor Q1 and thus establishes a corresponding voltage 
VBEwhich in turn is applied between base and emitter of Q2. Now, if Q2 is matched to Q1 or 
more specifically, if the EBJ area of Q2 is the same as that of Q1, and thus Q2 has the same 
scale current Is as Q1, then the collector current of Q2will be equal to that of Q1, that is, 
Io=IREF.For this to happen, however, Q2 must be operating in the active mode, which in turn is 
achieved so long as the collector voltage Vo is 0.3V higher than that of the emitter. To obtain a 
current transfer ratio other than unity, say m, we simply arrange that the area of the EBJ of Q2 

is m times that of Q1.In this case, Io=mIREF. 
 
Next we consider the effect of finite transistor β on the current transfer ratio. The analysis for 
the case in which the current transfer ratio is nominally unity -that is, for the case in which Q2 

is matched to Q1-is illustrated in Fig. 1. The key point here is that since Q1and Q2 are matched 
and have the same VBE their collector currents will be equal. The rest of the analysis is straight 
forward. A node equation at the collector of Q1 yields 

 

Finally, since Io=IC the current transfer ratio can be found as 

 

Note that as β approaches ∞, I o / I R E F  approaches the nominal value of unity. For typical values 
of β, however, the error in the current transfer ratio can be significant. For instance, β= 100 
results in a 2% error in the current transfer ratio. 

The BJT mirror his a finite output resistance Ro 
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Where VA, and ro2 are the Early voltage and the output resistance, respectively. of Q2Thus, 
even if we neglect the error due to finite β, the output current Io will be at its nominal value 
only when Q2 has the same VCE as Q1,namely at VO =VBE.As VO is increased, Io will 
correspondingly increase. Taking both the finite β and the finite Ro into account we can 
express the output current of a BJT mirror (with m=1) as 

 

Finally, if the current IREF is taken in a simple manner as in Fig. 2 above, then 
 

 

 
THE WILSON CURRENT MIRROR : 
 
At the cost of adding one more transistor an improved current mirror results, which exhibits 
both reduced dependence of the transfer ratio on β as well as increased output resistance. The 
drawback, in addition to the cost of an extra device, is that an additional VBE drop is required for 
its operation so that one must allow for about 1 V across the Wilson-mirror output. The analysis 
is shown below right on the figure (Fig. 3) and results in an output resistance of Ro=βro/2  (for 
β=100, 50 times as much as with the simple mirror ) and a transfer ratio 
 

 

So that with β=100 the ratio is 0.9998 or the error is 0.02% instead of 2% 
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Fig 3: The Wilson bipolar current mirror :(a)circuit showing analysis to 
determine the  current transfer ratio; and (b)determining the output 
resistance. Note that the current ix that enters Q3 must equal the sum of 
the currents that leave it, 2i. 
 
 

PRELAB ASSIGNMENT: 
Use the computer software tool OrCAD PSPICE to simulate the two lab activities. Make sure 
to bring the PSPICE results to the laboratory .In addition to being an aid in immediately 
verifying measured results ,they will be the basis of your Prelab grade for this lab. 

 
 Specifically, the Circuit drawings with the nodes labeled and with DC node voltages 

and all branch currents 
 
Fill in all entries in the tables provided below that are labeled “calculated”. 

 
 

PROCEDURE: 

LABORATORY ACTIVITIES: 
 
ACTIVITY 6.A: SIMPLE CURRENT SOURCE 
There will be two parts to this activity, each with a different resistance value for RL. 
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Fig 4: Simple current source .The transistors are 2N3904 
 

 6.A.a Build the circuit given in figure 4 with RL=0 Ω. 
 

(i) Using a DC ammeter, measure and record the DC branch currents for each 
resistor. Note: Due to self heating, the circuit will take around 30 seconds to settle. 
 

 

(ii) Calculate the output resistance, Ro,of the current source using the equation 

 
 

 Ro= ro= 
 
 

 6.A.b Build the circuit given in the above figure with RL= 1kΩ. 
 

(i) Using a DC ammeter, measure and record the DC branch currents for each 
resistor. Note: Due to self heating, the circuit will take around 30 seconds to settle. 
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Activity A. Part b:RL=1kΩ DC Currents 

 

(ii) Calculate the output resistance, Ro,of the current source using the equation 

 
 

      Ro= ro= 
 

(iii) Using the two operating points, one with RL =0Ω and one with RL =1kΩ, determine 
the actual value of the output resistance and actual value of VA. 

 

Activity 6.B: WILSON CURRENT MIRROR CIRCUIT: 

 
In this activity, a Wilson current mirror will be studied. There will be two parts of this 
activity with different resistance values for RL in each part , similar to Activity A. However, 
the values are not the same as in Activity A. 

 

 

Fig 5: Wilson Current Mirror, The transistors are 2N3904 
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 6.B.a Build the circuit given in figure 5 with RL=0 Ω. 

 
(i) Using a DC ammeter, measure and record the DC branch currents for each 

resistor.  
Note: Due to self heating, the circuit will take around 30 seconds to settle. 

 
Activity B. Part a : RL= 0 Ω 

 
 

(ii) Calculate the output resistance, Ro,of the current source using the equation 

 
 

 
 

 6.B. b Build the circuit given in the above figure with RL=470 Ω. 
(i) Using a DC ammeter, measure and record the DC branch currents for each 

resistor.  
Note: Due to self heating, the circuit will take around 30 seconds to settle. 
 

Activity B . Part b : RL= 470 Ω 

 
 

(ii) Calculate the output resistance, Ro,of the current source using the equation 

 

 

 

(iii) Using the two operating points, one with RL =0Ω and one with RL =470Ω, 
determine the actual value of the output resistance and actual value of VA. 
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CALCULATOIONS: 

Show all the calculations 
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RESULTS: 

BASIC BJT CURRENT SOURCE: 

Ro = ro(for RL =0) = 

Ro = ro (for RL =1k Ω) = 

Actual Value of Ro = 

Actual Value of VA = 

 

WILSON CURRENT MIRROR: 

 
Ro = ro (for RL =0) = 

Ro = ro (for RL =470 Ω) = 

Actual Value of Ro = 

Actual Value of VA = 
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Lab No. 9 

OBJECTIVE: 

To analyze the frequency response of Common Emitter Amplifier. 
 
 
EQUIPMENT REQUIRED:  

 
Protoboard 
Function Generator 
Digital Multimeter 
Power Supply 
Resistors 
Transistors: 1 x 2N3904 
 

THEORY: 

COMMON EMITTER AMPLIFIER: 

 

 

Fig1: Common Emitter Amplifier 

A Common-Emitter amplifier is one of three basic single-stage bipolar-junction-transistor 

(BJT) amplifier topologies, typically used as a voltage amplifier. In this circuit the base 

terminal of the transistor serves as the input, the collector is the output, and the emitter is 

common to both (for example, it may be tied to ground reference or a power supply rail), 

hence its name. The analogous field-effect transistor circuit is the common-source amplifier. 
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EMITTER DEGENERATION RESISTANCE RE: 

RE introduces negative feedback in the amplifier circuit. If for instance the collector current 

increases, the emitter current will also increase resulting in an increased voltage drop across 

RE. Thus the emitter voltage rises and the base-emitter voltage decreases .The latter effect 

causes the collector current to decrease, counteracting the initially assumed change, an indication of 

the presence of negative feedback. 

 

TRANSISTOR CAPACITANCES:  

C1 and C3 are coupling capacitors while C2 is bypass capacitor. There also exists internal 

capacitance between base and collector and base and base and emitter i-e Cbc and Cbe 

respectively. 

 

 

Fig 2: BJT Internal Capacitances Cbc and Cbe 

 

EFFECT OF COUPLING , BYPASS AND INTERNAL CAPACITANCES 

AT DC AND AT LOW FREQUENCIES: 

Since  XC=1/2πfC ,hence at low frequencies the reactance is greater and it decreases as the 

frequency increases. At low frequencies the reactance of coupling capacitance is high (The 

coupling and bypass capacitances are usually in microfarads) , hence they act as almost open 

circuit .Therefore at low frequencies the coupling capacitances act as nearly as open circuit  

The bypass capacitance also acts as nearly open circuit at low frequency.  
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Fig 3: Common Emitter amplifier at DC 

At lower frequencies, the internal capacitances Cbc and Cbe have a very high reactance 

because of their low capacitance value (usually a few picofarads) and the low frequency 

value .Therefore they look like opens and have no effect on transistor’s performance  

 

AT MID RANGE FREQUENCY: 

In mid range frequency the coupling and by-pass capacitance act as nearly short circuit. As 

the midrange frequency is also not much high and the internal transistor capacitances are also 

very small hence the internal transistor capacitances do not effect the transistor performance. 

Hence during mid range frequency the gain of the amplifier is maximum. 

 

Fig 4: Common Emitter Amplifier at Mid-Range frequency 
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AT HIGH FREQUENCIES: 

At high frequencies, the coupling and bypass capacitors become effective ac shorts and do 

not effect amplifier’s response .The reactance of internal transistor junction capacitances, 

(Cbc and Cbe ) become small enough and a significant amount of signal voltage is lost due to 

the voltage divider effect of signal source resistance and the reactance of Cbe as shown in 

figure .When the reactance of Cbc becomes small enough , a significant amount of output 

signal is fed back out of phase with the input (negative feedback) thus effectively reducing 

the voltage gain which is as illustrated in figure : 

The effect of  Cbc can be explained much clearly using Miller’s theorem.  

 
Fig 5a : Effect of Cbc where Vb is reduced by the            Fig 5 b: Effect of Cbc , where part of Vout  

voltage-divider action of R3 and XCbe               (Vfb) goes back through Cbc to the base  

       and reduces the input signal because  

       it is  approximately 180o out of phase  

       with Vin 

 
 

MILLER’S THEOREM IN HIGH-FREQUENCY ANALYSIS: 

The capacitance Cbc in BJT between the input and output is shown in a generalized form in 

Fig 6 .AV is the absolute voltage gain of the amplifier at midrange frequencies and C 

represents Cbc  
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Fig 6: General case of Miller input and output capacitances.  

 

Miller’s theorem  states that C effectively appears as a capacitance from input to ground  

C୧୬	ሺ୑୧୪୪ୣ୰ሻ ൌ 		 C௕௖	ሺܣ௩ ൅ 1ሻ 

 ሺ୑୧୪୪ୣ୰ሻ	௕௖appears as a capacitance to ac ground, in parallel with C୧୬ܥ

For e.g if Cbc = 6pF and the amplifier gain is 50 then Cin (Miller)= 306pF. 

Miller’s theorem also states that C effectively appears as a capacitance from output to ground  

 

௢௨௧ሺெ௜௟௟௘௥ሻܥ ൌ 	ሺ	௕௖ܥ	
		௩ܣ ൅ 1
௩ܣ

	ሻ 

 

These two Miller capacitances create a high frequency input RC circuit and a high frequency 

output RC circuit which is as shown in figure: 

 

Fig 7: Amplifier ac equivalent circuits showing internal capacitances and effective Miller capacitances 
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PRELAB ASSIGNMENT: 

The Common Emitter amplifier circuit that is to be simulated and implemented on bread board is 

as shown below:  

 
Use the computer software tool OrCAD PSPICE to simulate the circuit. Make sure to bring 
the PSPICE results to the laboratory. In addition to being an aid in immediately 
verifying measured results, they will be the basis of your Prelab grade for this lab. 

 
Specifically, the following items must be addressed using OrCAD PSPICE as part of the 
prelab assignment: 

 
• Circuit drawings with the nodes labeled and with DC node voltages. 
• Transient response (time-domain) with Vin = 2V, showing plots of Base voltage (input 

voltage)  and voltage across load (output voltage) waveforms separately. Also mark 
label to the maximum output voltage (using pspice) 

• AC Sweep/Noise response, showing waveform of output voltage Vs Frequency.  
 
 

Fill in all entries in the tables provided below that are labeled “simulated”. 
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DC PARAMETERS: 
 

 Simulated Measured % 
error 

VB  

(Volts) 
   

VC 
           (Volts) 

   

VE 
            (Volts)

   

 
 
TRANSIENT RESPONSE: 

 
Vin (at base) : 
 

Simulated Measured % error 
 
 

  

 

     Vout (across load) 

Simulated Measured % error 
 
 

  

 

  Gain Calculated: 

Simulated Measured % error 
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FREQUENCY RESPONSE: 

Frequency Vout (Simulated) Vout (Measured) 

   

   

   

   

   

   

   

   

   

 

Draw a plot of the output voltage Vs Frequency using semi log graph paper. 

 

RESULT: 

Phase Shift between input and output signal -------------------------. 

The upper critical frequency as determined from the graph is -----------------------. 
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Lab No. 10 

OBJECTIVE: 

To analyze the frequency response of Cascode Amplifier and compare it with Common Emitter 
Amplifier. 
 
 
EQUIPMENT REQUIRED:  

 
Protoboard 
Function Generator 
Digital Multimeter 
Power Supply 
Resistors 
Transistors: 2 x 2N3904 
 

THEORY: 

 
Cascode amplifier is about a compound structure that consists of a common emitter and a 
common base amplifier. 
 
While the C-B (common-base) amplifier is known for wider bandwidth than the C-E (common-
emitter) configuration, the low input impedance (10s of Ω) of C-B is a limitation for many 
applications. The solution is to precede the C-B stage by a low gain C-E stage which has 
moderately high input impedance (kΩs). The stages are in a cascode configuration, stacked in 
series, as opposed to cascaded for a standard amplifier chain. The cascode amplifier 
configuration has both wide bandwidth and moderately high input impedance.  
 
The cascode amplifier preserves all the features of a common emitter amplifier as far as the 
voltage and current gains, the equivalent input resistance and the output resistance are concerned. 
Cascode amplifiers are designed to extent the frequency range of operation of common emitter 
amplifiers to higher frequencies. This performance is due to the presence of the common base 
amplifier. 
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Fig 1: This is an AC circuit equivalent with batteries and capacitors replaced by short circuits. 

 

A common-base configuration is not subject to the Miller effect because the grounded base 
shields the collector signal from being fed back to the emitter input. Thus, a C-B amplifier 
has better high frequency response.  

To have moderately high input impedance, the C-E stage is still desirable.  
 
 

PRELAB ASSIGNMENT: 

The Cascode amplifier circuit that is to be simulated and implemented on bread board is as 

shown below:  

 

 
 

 



Analog	Integrated	Circuit	 	 Lab	No.10 

50 
 

NED University of Engineering & Technology, Department of Electronic Engineering 

 
 

Use the computer software tool OrCAD PSPICE to simulate the circuit. Make sure to bring 
the PSPICE results to the laboratory. In addition to being an aid in immediately 
verifying measured results, they will be the basis of your Prelab grade for this lab. 

 
Specifically, the following items must be addressed using OrCAD PSPICE as part of the 
prelab assignment: 

 
• Transient response (time-domain) with Vin = 2V, showing plots of Base voltage (input 

voltage)  and voltage across load (output voltage) waveforms separately. Also mark 
label to the maximum output voltage (using pspice) 

• AC Sweep/Noise response, showing waveform of output voltage Vs Frequency.  
 
 

Fill in all entries in the tables provided below that are labeled “simulated”. 
 
 
TRANSIENT RESPONSE: 

 
Vin (at base): 
 

Simulated Measured % error 
 
 

  

 

     Vout (across load) 

Simulated Measured % error 
 
 

  

 

  Gain Calculated: 

Simulated Measured % error 
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FREQUENCY RESPONSE: 

Frequency Vout (Simulated) Vout (Measured) 

   

   

   

   

   

   

   

   

   

 

Draw a plot of the output voltage Vs Frequency using semi log graph paper. 

 

Result: 

Phase Shift between input and output signal -------------------------. 

The upper critical frequency as determined from the graph is -----------------------. 

As compared to CE amplifier the upper critical frequency of Cascode Amplifier is increased 

by -----------------. 
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Lab No. 11 

 
OBJECTIVE: 
Design and analyze a Common Gate Amplifier circuit. 

 
 
EQUIPMENT REQUIRED:  

 
Protoboard 
Function Generator 
Digital Multimeter 
Power Supply 
Resistors 
Transistors: 1 x 2N7000 
 

 

THEORY: 

BACKGROUND: 
MOS transistor is a voltage controlled device, where gate voltage modulates the channel 
resistance and voltage between drain and source determines current flow between the drain 
and source terminals. Like BJT, MOS transistor can perform as amplifier and as electronic 
switch. MOS comes in two different flavors, as NMOS and as PMOS.  

 
MOS AMPLIFIERS:  
Three common MOS amplifiers are common source, common drain and common gate.  
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COMMON GATE AMPLIFIER: 
As shown in figure 1 the common gate amplifier has a grounded gate terminal , a signal input 
at the source terminal and the output taken at the drain. 
 
 

 
 

Fig 1: Common Gate Amplifier 
 

 
 

Its input resistance is  

ܴ௜௡ ൌ
1
݃௠

 

 
And voltage gain is: 

௩ܩ ൌ
݃௠	ܴ஽			ു	ܴ௅
1 ൅ ݃௠ܴ௦௜௚

 

Small Signal current gain: 

       

	௜ܩ ൌ
ܴ஽

ܴ஽	 ൅ ܴ௅
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Output Resistance: 

      ܴ௢௨௧	 ൌ 	ܴ஽ 

 

Hence Common Gate amplifiers have  

 Non-Inverting output  
 Moderate input resistance 
 Moderately large small signal voltage gain but smaller than common source amplifier. 
 Small signal current gain less than one 
 Potentially large output resistance (Dependent on RD) 

 
 
 
Design a common gate amplifier using 2N7000 transistor that meets the following 
specifications: 
ID= 10mA 
VCC =12V 
 
 

PRELAB ASSIGNMENT: 

 
Step1:  
Determine the values of VGS and gm. 
Use OrCAD PSPICE simulation to find VGS required to yield the current . Plot IDVs VGS 
curve . Make sure to bring the PSPICE results to the laboratory. Take two points in the 
region near 10mA and determine gm in the small linear region. 
 
Step 2:  
Determine the value of RD and RS 
Maximum and minimum voltage at the drain node of the amplifier can vary from VCC 

(when ID=0) to almost zero when voltage drop between drain and ground is very 

small.We want the AC signal to swing symetrically around the mid-point of the power 

supply (1/2 VCC) 

RD= (VCC-VC)/ID 

Let RS be 10% of RD 
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Step 3:  
With VG= VS+VGS  (where VGS is to be used at ID = 10mA )  .Select the value of R1 and 
R2 such that the voltage at the gate is as desired and the current through the resistance RD 
is nearly 10mA and the drain current remains stable at the value calculated. 
 
Step 4:  
Use a 1u capacitor between gate and ground terminal and a 10u capacitor between the  
sin source and Rs. 
 
The Common Gate amplifier circuit that is to be simulated and implemented on bread 
board is as shown below: 
 

 
 
 
Use the computer software tool OrCAD PSPICE to simulate the circuit.  
Make sure to  bring the PSPICE results to the laboratory .In addition to being an aid in 
immediately verifying measured results,they will be the basis of your Prelab grade 
for this lab. 

 
Specifically, the following items must be addressed using OrCAD PSPICE as part of the 
prelab assignment: 

 
 Circuit drawings with the nodes labeled and with DC node voltages, and DC 

currents through all branches. 
 Transient response (time-domain) with Vin = 10mV, showing plots of source 

voltage (input voltage) and drain voltage (output voltage) waveforms 
separately. Also mark label to the maximum output voltage (using pspice) 
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 CALCULATIONS: 
 
Show all the calculations for determining RD, RS, VS, VG, R1 and R2. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
RESULT: 
The gain of the common gate amplifier as determined by the circuit is: -----------------------      
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Lab No. 12 

OBJECTIVE: 

To demonstrate the properties of differential amplifiers in both common mode and differential 
mode. 

 
EQUIPMENT REQUIRED:  

Protoboard 
Function Generator 
Digital Multimeter 
Power Supply 
Resistors  
Capacitors 
Transistors: 4 x Q2N3904 
 

THEORY: 

BASIC OPERATION OF THE BJT DIFFERENTIAL PAIR 

 

Fig 1 : Different modes of operation of the BJT differential pair: (a) The differential pair with a 
common-mode input signal vCM. (b) The differential pair with a large differential input signal. 
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First consider the case of Figure 1a where the two bases are tied together. Then vB1 = vB2 = vCM  . If 
Q1 and Q2 are matched, and assuming an ideal bias current source I with infinite output 
resistance, it follows that the current I will remain constant and from symmetry that I will divide 
equally between Q1 and Q2. Thus iE1= iE2 = I/2, and the voltage at the emitters will be vCM -VBE 

where VBE is the base-emitter voltage (assumed to be approximately 0.7 V) corresponding to an 
emitter current of I/2. The voltage at each collector will be VCC-1/2 αIRC, and the difference in 
voltage between the two collectors will be zero.  

Now let us vary the value of the common-mode input signal vCM. Obviously, as long as Q1 and 
Q2 remain in the active region the current I will still divide equally between Q1 and Q2, and the 
voltages at the collectors will not change. Thus the ideal differential pair does not respond to 
(i.e., it rejects) common-mode input signals.  

As another experiment, let the voltage vB22 be set to a constant value, say, zero (by grounding 
B2), and let vB2 = +1 V (see Fig.1b). With a bit of reasoning, it can be seen that Q1 will be on 

and conducting all of the current I and that Q2 will be off. For Q1 to be on (with VBE1 = 0.7 V) 
the emitter has to be at approximately +0.3 V, which keeps the EBJ of Q2  reverse-biased. The 
collector voltages will be, vC1 = VCC-αIRC and vC2 =VCC.  

 

Fig 1 ( Continued ) (c) The differential pair with a large differential input signal of polarity 
opposite to that in ( b) .(d) The differential pair with a small differential input signal vi . Note that 
we have assumed the bias current source I to be ideal (i.e., it has an infinite output resistance) 
and thus I remains constant with the change in vCM  
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Let us now change vB1 to -1 V (Fig.1c). Again with some reasoning it can be seen that Q1 
will turn off and Q2 will carry all the current I. The common emitter will be at -0.7 V, which 
means that the EBJ of Q1 will be reverse-biased by 0.3 V. The collector voltages will be     
vC2 = VCC-αIRC and vC1 =VCC.  

From the foregoing, we see that the differential pair certainly responds to large difference-mode 
(or differential) signals. In fact, with relatively small difference voltages we are able to steer the 
entire bias current from one side of the pair to the other.  

To use the BJT differential pair as a linear amplifier we apply a very small differential signal (a 
few millivolts), which will result in one of the transistors conducting a current of  I/2 + ∆I: the 
current in the other transistor will be I/2 + ∆I , with  ∆I  being proportional to the difference 
input voltage (see Fig. 1d). The output voltage taken between the two collectors will be 2α∆IRC, 
which is proportional to the differential input signal vi. 

 

PROCEDURE: 

LABORATORY ACTIVITIES: 
  

Plot the ic_vbe curve, and ib_vbe curve. Let IC = 1mA . At that point measure VBE . Next 
simulate the ib_vbe curve at VBE and measure IB . From here determine the β of the transistor at 
IC = 1mA. 
 

 DIFFERNTIAL PAIR WITH RESISTIVE LOAD  

With the inputs being grounded design a Differential amplifier circuit which is biased by 
a current source which has the collector voltage at Q3 and Q4 to be 5V. The collector currents of 
Q3 and Q4 to be 1mA.  Calculate R3 and R2 for the two transistors .Determine the emitter current 
of Q3 and Q4. Determine the value of R1 for the circuit so that the collector currents of Q3 and Q4 
remain constant at nearly 1mA. 
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Fill the table below:  
 

 Vsim Vmeas 
VE1,VE2   
VB1,VC1,VB2   
VC2,VE3,VE4   
VB3   
VB4   
VC3   
VC4   

 
 

 
Transient response:  

1) Apply a 30 mV amplitude,1kHz sine wave to vin+ and ground vin− . Fill in the table below: 
 

 Vsim Vmeas 
vb3   
vc3   
vb4   
vc4   
∆vout   

 
 
 

2) Apply a 100 mV amplitude,1kHz sine wave to vin+ and 90mV signal to vin− . Fill in the 
table below: 

 
 Vsim Vmeas 
vb3   
vc3   
vb4   
vc4   
∆vout   

 
 
 

RESULTS: 
a) With the base of Q3 and Q4 grounded; 

The differential gain of the circuit from simulation comes out to be: ------------------ 
The differential gain of the circuit as measured comes out to be: ------------------ 
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b) By applying a 30 mV amplitude,1kHz sine wave to vin+ and ground vin−; 

The differential gain of the circuit from simulation comes out to be: ------------------ 
The differential gain of the circuit as measured comes out to be: ------------------ 

 
 
 

c) By applying a 100 mV amplitude,1kHz sine wave to vin+ and 90mV signal to vin−; 
The differential gain of the circuit from simulation comes out to be: ------------------ 
The differential gain of the circuit as measured comes out to be: ------------------ 
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Lab No. 13 
 
OBJECTIVE: 
To measure the open loop gain and offset voltage of an op amp. 
 
 
EQUIPMENT REQUIRED:  

Protoboard 
Function Generator 
Digital Multimeter 
Power Supply 
Resistors  
741 op-amp 
 
 
THEORY: 
 

Introduction 
An operational amplifier, (or "op amp" as commonly known), has two inputs as shown in 
Figure  

 
Fig.1  

 
The output voltage Vo is proportional to the difference in voltage between the two inputs, 
and is given by: 

 
Vo = Gv. (Vb –Va) 

 
where Gv is a large number, possibly as high as 1,000,000. Ideally, op amps should have: 
infinite input impedance zero currents flowing into the inputs zero output impedance. 

 
However the characteristics of real op amps differ from the ideal. The key characteristics 
are: 
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The offset voltage -this is the voltage which when applied across the two inputs 
produces a zero voltage on the output 

 
The bias and offset currents are currents flowing into the inputs I 

 
The input impedance (usually high, but not infinite), and the output impedance 
(low but not zero). 

 
The way in which the characteristics change with frequency. 

 

OFFSET VOLTAGE  : 

This is the voltage which must be applied across the inputs to produce a zero voltage output. 
Generally with no input voltage the output is not zero, as expected with a perfect amplifier. 
This is because of slight differences, or asymmetries in the circuit. In other words the offset 
voltage is the voltage needed to counterbalance the small voltage normally present at the 
input. 
The circuit used to measure the offset is shown in fig.   . Vo is the unwanted output voltage, 
caused by Vi at the input. 

 
 

Fig. 2  
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Open Loop Gain Measurement 
 

 
 

  Fig. 3 
 

 Implement the circuit of fig.3  
 Connect Function Generator at resistance R1. 
 Set the Function Generator to 100 Hz frequency, and 10 Vpp. 
 Connect the oscilloscope probe to the output of the amplifier. 
 If it shows saturation, reduce input until it shows normal waveform. 
 Using potentiometer R6 adjust the average value of the output voltage to 

be zero, by applying a bias voltage to the inverting input (OFFSET voltage 
compensation). 

 Measure the peak-to-peak Voltage V1 present at the negative pin of LM741. 
 Measure the output voltage of the op amp . 
 Measure the values of the resistors used in this experiment. 
 Using formula calculate the gain of operational amplifier. 

 
Gv = Vo (Rin + R2) / ( V1 * Rin) 
Where Rin = R4 // to ( R5 +R6 ) 
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OFFSET VOLTAGE MEASUREMENT: 
 

 
Fig.4 

 
 Implement the circuit of fig.4  
 With the multimeter (function VDC) measure the output voltage of the operational 

amplifier. 
 

 
OUTCOME: 
The open loop gain comes out to be: 
The offset voltage comes out to be: 
 
 

 



Analog	Integrated	Circuit	 	 Lab	No.14 

66 
 

NED University of Engineering & Technology, Department of Electronic Engineering 

 
 

Lab No. 14 
 
OBJECTIVE: 
To measure the slew rate and bandwidth of an op amp. 
 
 
EQUIPMENT REQUIRED:  

Protoboard 
Function Generator 
Digital Multimeter 
Power Supply 
Resistors  
741 op-amp 
 
 
THEORY: 

The slew rate is defined as the speed with which the amplifier can change its  
output voltage. This parameter is measured in volts/second (or volts/µs) and can  
be measured with the circuit shown in Fig. 1. 

 
SR= (dVo (t) /dt) max 

 
To measure this parameter, apply a square wave signal to the amplifier input and  
measure the change in output voltage during a short time interval (e.g. in one µs) 
 
 

 
Fig. 1  
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Fig. 2 

 
 
SLEW RATE MEASUREMENT 

 Implement the circuit in fig.2  
 Apply a square-wave signal, 10 KHz, 3Vpp and zero average voltage value between 
      terminal 2 and ground. 
 Connect the first probe of the oscilloscope to the input of the circuit (terminal 2) and 
      the second to the output of the amplifier. 
 Measure the time taken for the output to raise from -1 V to + 1 V. 

 
BANDWIDTH: 

 Keep the previous circuit as shown in fig.2 
 Apply a Sine wave, 100Hz, 1Vpp between input terminals. 
 Note down the output voltage. 
 Increase the frequency to all values shown in table and record the output voltage at each 

frequency. 
 Plot the graph of output voltage w.r.t frequency. 
 Determine the frequency at which the output voltage drops to 0.707 of its maximum 

value. 
 Measure the frequency for which the amplification is equal to 1. 
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OBSERVATION: 
 
SLEW RATE  

 
 
BANDWIDTH: 
 

Input Frequency Output Voltage  
100Hz  
500Hz  
1KHz  
10KHz  
20KHz  
50KHz  
100KHz  
200KHz  
500KHz  

 
 
OUTCOME: 

 The slew rate of the op-amp comes out to be… 
 The bandwidth of the op-amp comes out to be… 
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